Pro Tools
AVoption & AVoption|XL Guide
Version 5.1 for Macintosh

Digidesign Inc.
3401-A Hillview Avenue
Palo Alto, CA 94304 USA
tel: 650-842-7900
fax: 650-842-7999

Technical Support (USA)
650-842-6699
650-856-4275

Product Information (USA)
650-842-6602
800-333-2137

Fax on Demand (USA)
1-888-USE-DIGI (873-3444)

International Offices
Visit the Digidesign Web site for contact information.

World Wide Web
www.digidesign.com

Digidesign FTP Site
ftp.digidesign.com
Copyright
This User’s Guide is copyrighted ©2001 by Digidesign, a division of Avid Technology, Inc. (hereafter “Digidesign”), with all rights reserved. Under copyright laws, this manual may not be duplicated in whole or in part without the written consent of Digidesign.

DIGIDESIGN, AVID and PRO TOOLS are trademarks or registered trademarks of Digidesign and/or Avid Technology, Inc. All other trademarks are the property of their respective owners.

All features and specifications subject to change without notice.
PN 932708445-00 REV A 01/01
Chapter 5. Installing AVoption XL ................................................................. 23
   Installing a New AVoption XL System .................................................... 23
   Installing AVoption XL as an Upgrade .................................................. 23
   Installing AVoption XL Software ........................................................ 24
   Installing AVoption XL Hardware ......................................................... 24
   Installing the ATTO EPCI-UL2D SCSI Accelerator ............................. 26
   AVoption XL Video Connections .......................................................... 28
   Meridiem I/O Box .............................................................................. 29
   Using NTSC and PAL ........................................................................... 33

Chapter 6. Recording and Adding to the Movie Track ................................. 35
   The Movie Track ................................................................................. 35
   Setting S-Video or Component Output ................................................. 36
   Movie Track Options ........................................................................... 36
   Recording Video .................................................................................. 37
   Exporting Files from Avid Programs ................................................... 39
   Adding Movie Files with AVoption and AVoption XL ......................... 41
   Importing Movies (QuickTime) ............................................................ 41
   Undo/Redo for Video Editing Commands ............................................. 42
   Performance Guidelines ....................................................................... 42

Chapter 7. Playing and Editing the Movie Track .......................................... 43
   Movie Online ....................................................................................... 43
   Movie Offline ....................................................................................... 43
   Playback Viewing Options .................................................................... 44
   Moving the Movie Track or Video Clips ............................................... 45
   Copying Video Clips ............................................................................. 46
   Clearing Selected Video Clips .............................................................. 46
   Sync Points ......................................................................................... 47
   Locking the Movie Track ...................................................................... 47
AVoption and AVoption XL combine the powerful audio post-production features of Pro Tools with integrated support for the import, capture, and playback of Avid video media.

**AVoption Components**

AVoption consists of software and two Avid video cards that you install in a Pro Tools audio system. The Digidesign audio hardware provides digital audio recording, editing, mixing, and processing. The Avid video hardware provides video capture and import, full-screen video playback on an external PAL or NTSC monitor, video playback in an on-screen window, and professional quality video compression.

**AVoption Capabilities**

AVoption lets you:

- Import and capture multiple NTSC or PAL video clips to the Movie track.
- Play the Movie track with near sample-accurate precision against audio tracks in a Pro Tools session.
- Spot or Slip the Movie track to a new time code location, and spot audio to the video track.
- Spot individual video clips to new locations in the Movie track.
- View video edits and clip definitions in the Movie track.
- View the Movie track as a series of picture frames.
- Play video on an external NTSC or PAL monitor.
- Play video in a floating window on your computer monitor.

You can also:

- Import MFM (Media File Manager format) or MSM (Media Stream Manager format) video files created on Avid systems, such as Media Composer, Xpress/Mac, and AudioVision into the Movie Track of a Pro Tools session.
- Capture MSM format video media in the Movie Track of a Pro Tools session, while recording audio simultaneously.
AVoption XL Components

AVoption XL consists of software, a PCI card that you install in a Pro Tools audio system, and an external I/O box that connects to the PCI card. The Digidesign audio hardware provides digital audio recording, editing, mixing, and processing. The Avid video hardware provides video capture and import, full-screen video playback on an external PAL or NTSC monitor, professional quality video compression, and the capability to record and play back uncompressed video.

AVoption XL Capabilities

AVoption XL lets you:

• Import and capture multiple NTSC or PAL video clips to the Movie track.

• Play the Movie Track with near sample-accurate precision against audio tracks in a Pro Tools session.

• Spot or Slip the video track to a new time code location, and spot audio to the video track.

• Spot individual video clips to new locations in the Movie track.

• View video edits and clip definitions in the Movie Track.

• View the Movie track as a series of picture frames.

• Play video on an external NTSC or PAL monitor.

You can also:

• Import JFIF video media files from Meridian-based Avid systems (Mac or Windows) such as Media Composer, Symphony, and Xpress into the Movie Track of a Pro Tools session, while recording audio simultaneously.

• Capture JFIF format video media in the Movie Track of a Pro Tools session.

FilmFrame

The FilmFrame™ option enables 24 fps support in AVoption. With FilmFrame installed and authorized, you can import and play back Avid Film Composer media files. For more information on FilmFrame, contact your Digidesign dealer or visit the Digidesign Web site.
AVoption hardware consists of two cards: an Avid Broadcast Video Board (ABVB), and a Janus Advanced JPEG Compression card. These cards connect with a ribbon cable. The ABVB breakout cable is also included.

**AVoption Hardware Capabilities**

AVoption hardware:
- Receives composite or component video signal.
- Digitizes incoming video.
- Compresses digitized video using advanced JPEG compression.
- Outputs composite and component video signals.
- Connects to a second VGA monitor (optional) for displaying the Movie window.

**Avid Video Resolutions (AVR)**

The ABVB captures and plays back video media with JPEG compression technology, expressed as Avid Video Resolution (AVR) levels, in the MSM media format (Media Composer 7.x compatible). AVoption can import both MSM video and MFM video, which is generated by AudioVision 4.x and Media Composer 6.x.

AVR levels dictate the amount of JPEG compression, which determines image quality and storage requirements for digitized video.

The following resolutions are available:
- Single-field – AVR 2s, AVR 3s, AVR 4s, AVR 6s, AVR 8s, AVR 9s
- Two-field – AVR 12, AVR 70, AVR 70B, AVR 71, AVR 75, AVR 75B, AVR 77

Lower numbered AVR levels require less hard drive space, but provide lower resolution than higher numbered AVR levels.

The lowest resolution is AVR 2m. The maximum resolution is AVR 77 and is considered to be broadcast quality.
**JPEG Compression and Storage**

JPEG compression varies according to the complexity of the footage. For example, a medium shot of a talking head with a simple background would compress more (using less disk space) than a panning shot of a stadium full of people.

The following tables list the approximate amount of video storage, in minutes per gigabyte, required for each AVR level.

### Storage for AVR 2s – AVR 9s

<table>
<thead>
<tr>
<th>AVR level</th>
<th>30/25 FPS Storage (Minutes/GB)</th>
<th>24 FPS Storage (Minutes/GB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVR 2s</td>
<td>40–74</td>
<td>50–93</td>
</tr>
<tr>
<td>AVR 3s</td>
<td>32–57</td>
<td>40–71</td>
</tr>
<tr>
<td>AVR 4s</td>
<td>19–40</td>
<td>24–50</td>
</tr>
<tr>
<td>AVR 6s</td>
<td>11–33</td>
<td>14–41</td>
</tr>
<tr>
<td>AVR 8s</td>
<td>5–13</td>
<td>6–16</td>
</tr>
<tr>
<td>AVR 9s</td>
<td>3–6</td>
<td>4–7</td>
</tr>
</tbody>
</table>

### Storage for AVR 12 and AVR 70 – AVR 77

<table>
<thead>
<tr>
<th>AVR level</th>
<th>30/25 FPS Storage (Minutes/GB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVR 12</td>
<td>18–34</td>
</tr>
<tr>
<td>AVR 70</td>
<td>5–11</td>
</tr>
<tr>
<td>AVR 70B</td>
<td></td>
</tr>
<tr>
<td>AVR 71</td>
<td>4–11</td>
</tr>
<tr>
<td>AVR 75</td>
<td>3–8</td>
</tr>
<tr>
<td>AVR 75B</td>
<td></td>
</tr>
<tr>
<td>AVR 77</td>
<td>2–6</td>
</tr>
</tbody>
</table>

---

**Required Hardware**

To install and use AVoption, you must first install a currently supported version of Pro Tools 24 or Pro Tools 24 MIX hardware. Other hardware required for AVoption is listed in this section, along with system requirements for AVoption.

For an up-to-date list of Digidesign-qualified computers, video cards, SCSI accelerators, and hard drives, visit the Digidesign Web site (www.digidesign.com/compato).

**Supported Computers**

- Power Macintosh 9500
- Power Macintosh 9600
- Power Macintosh G3 (Blue & White)
- Power Macintosh G4

If you are using a Blue & White G3 or a G4, a qualified expansion chassis is required.

Older G3 Macintosh systems (beige) are not supported.
### Minimum System Requirements

#### Minimum Pro Tools AVoption System Requirements

<table>
<thead>
<tr>
<th>Item</th>
<th>Minimum Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>Power Macintosh 9500&lt;br&gt;Power Macintosh 9600&lt;br&gt;Power Macintosh G3 (Blue &amp; White)&lt;br&gt;Power Macintosh G4</td>
</tr>
<tr>
<td>Pro Tools audio hardware</td>
<td>Pro Tools 24&lt;br&gt;Pro Tools 24 MIX&lt;br&gt;Pro Tools 24 MIXplus</td>
</tr>
<tr>
<td>PCI Expansion Chassis (Blue &amp; White G3)</td>
<td>Magma 13-slot</td>
</tr>
<tr>
<td>SCSI accelerator</td>
<td>ATTO ExpressPCI Dual-Channel&lt;br&gt;(Other SCSI accelerators may be approved. Check the Digidesign Web site for the latest compatibility information.)</td>
</tr>
<tr>
<td>SCSI hard drives</td>
<td>at least 2 approved SCSI hard drives</td>
</tr>
<tr>
<td>Sync peripheral</td>
<td>Universal Slave Driver (USD)</td>
</tr>
</tbody>
</table>

### Storage Hardware

#### SCSI Accelerators

To support the high transfer rates required by AVoption audio and video, the ATTO Express PCI Dual-Channel SCSI Accelerator (or other AVoption-qualified SCSI accelerator) is required, with audio drives connected to one channel and video drives connected to the other channel.

#### SCSI Hard Drives

##### Using Two Hard Drives

For scenarios that do not require a high audio track count or a very long video segment, use two hard drives. In this scenario, one drive is used to record, import, and play back audio data, and the other is used to do the same for video.

##### Using More Than Two Hard Drives

To get the highest possible performance from your AVoption system, you can use more than two hard drives. In this scenario, you can use up to four hard drives for audio data and up to four hard drives for video data.

**Audio** AVoption can use multiple hard drives to store audio data. You should allocate audio tracks to different hard drives manually. “Round robin” disk allocation is not recommended in a system that includes video drives.

**Video** AVoption can capture a contiguous video track to multiple hard drives. This is useful if the length of your video session exceeds the 2 GB Mac OS file size limit, or the storage space available on a single drive. For example, 50 minutes of video material, using AVR 77 compression, requires between 9 GB and 25 GB of storage.

### Sync Hardware

#### Synchronization Peripheral

AVoption requires a Universal Slave Driver (USD).

#### Sync Source

For accurate synchronization during capture and playback, Pro Tools and AVoption must both be locked to video black burst.
space. To store this much video, you need between one and three 9 GB hard drives. The video is automatically split by AVoption into several linked files of less than 2 GB on each disk.
AVoption XL Hardware Overview

AVoption XL consists of two hardware components: a Meridien Digital Media Board that installs in a PCI slot in your computer, and a Meridien I/O Box that connects to the card in your computer. A Video I/O Board, installed in the Meridien I/O Box, provides video inputs and outputs from your computer to the rest of your video equipment.

AVoption XL Hardware Capabilities

AVoption XL hardware:
- Receives composite, component, S-video, or (optional) SDI video signal.
- Digitizes incoming video.
- Compresses digitized video using advanced JFIF compression.
- Outputs composite, component, S-video, and (optional) SDI video signals.
- Captures and plays back uncompressed video.

JFIF Video Compression

The Meridien board captures and plays back video media in JPEG File Interchange Format (JFIF). JFIF compression levels provide variable levels of compression for your video project, depending on the recording input selected. The available JFIF resolutions are:
- Single field – 15:1s, 4:1s, 2:1s
- Two fields – 20:1, 10:1, 3:1, 2:1, 1:1 (uncompressed)

Higher JFIF compression ratios require less storage space but provide decreased video resolution than lower compression ratios.

The lowest JFIF resolution is 15:1s. The maximum resolution is 1:1 (uncompressed).

JFIF Compression and Storage

JFIF compression levels vary slightly, depending on the video input selected. 1:1 (uncompressed) data storage levels are not approximate. The amount of data required to store 1:1 video is always the same, regardless of the video input used.
The following tables list the approximate amount of video storage, in megabytes per second, required for each JFIF compression level.

### Required Hardware

To install and use AVoption XL, you must first install a currently supported version of Pro Tools 24 or Pro Tools 24 MIX hardware. Other hardware requirements and system requirements for AVoption XL are listed in this section.

For an up-to-date list of Digidesign-qualified computers, video cards, SCSI accelerators, and hard drives, visit the Digidesign Web site (www.digidesign.com/compato).

### Supported CPU's

- Power Macintosh 9600
- Power Macintosh G3 (Blue & White)
- Power Macintosh G4

Older G3 Macintosh systems (beige) are not supported.

### Minimum System Requirements

#### 3:1 Video Compression or Higher

<table>
<thead>
<tr>
<th>Item</th>
<th>Minimum Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Power Macintosh 9600, Blue &amp; White G3, or G4</td>
</tr>
<tr>
<td>PCI Expansion Chassis</td>
<td>Magma 13-Slot</td>
</tr>
<tr>
<td>SCSI accelerator</td>
<td>Qualified SCSI accelerator (ATTO EPCI-DC or Digidesign SCSI 64)</td>
</tr>
<tr>
<td>SCSI hard drives</td>
<td>Qualified drives are required; see the Digidesign Web site for more information.</td>
</tr>
<tr>
<td>Sync peripheral</td>
<td>Universal Slave Driver (USD)</td>
</tr>
</tbody>
</table>
### 2:1 Video Compression or 1:1 (Uncompressed)

#### Storage Hardware

**SCSI Accelerators**
To support the high transfer rates required by AVoption XL video, a qualified SCSI accelerator is required, with audio drives connected to one channel and video drives connected to the other channel. For 2:1 compression or 1:1 uncompressed video, 2 SCSI accelerators are required.

**SCSI Hardware and Drives with Video Compression Level 3:1 or Higher**
If you are using 3:1 video compression or higher at all times, then your system requires only a single dual channel SCSI accelerator, the ATTO EPCI-UL2D or EPCI-DC, or the Digidesign SCSI 64, with audio drives connected to one channel and video drives connected to another.

**Using Two Hard Drives**
For scenarios that do not require a high audio track count or a very long video segment, you may use two hard drives.

In this scenario, one drive is used to record, import, and play back audio data, and the other is used to do the same for video.

**Using More Than Two Hard Drives**
To get the highest possible performance from your AVoption XL system, you can use more than two hard drives. In this scenario, you can use many striped hard drives for audio and video data. Striped volumes appear to AVoption XL as a single volume.

### Minimum AVoption XL System Requirements

<table>
<thead>
<tr>
<th>Item</th>
<th>Minimum Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CPU</strong></td>
<td>Power Macintosh 9600, Blue &amp; White G3, or G4</td>
</tr>
<tr>
<td><strong>PCI Expansion Chassis</strong></td>
<td>Magma 13-Slot</td>
</tr>
<tr>
<td><strong>SCSI accelerator (video)</strong></td>
<td>Qualified SCSI accelerator (ATTO EPCI-UL2D LVD Accelerator required for 2:1 or 1:1 video compression)</td>
</tr>
<tr>
<td><strong>SCSI accelerator (audio)</strong></td>
<td>Qualified SCSI accelerator (ATTO EPCI-DC or Digidesign SCSI 64 required for 2:1 or 1:1 video compression)</td>
</tr>
<tr>
<td><strong>SCSI hard drives</strong></td>
<td>Qualified drives are required; see the Digidesign Web site for more information.</td>
</tr>
</tbody>
</table>
| **Striped hard drives** | A 2-way stripe is required for 2:1 compressed video.  
A 4-way stripe is required for uncompressed (1:1) video. |
| **Sync peripheral**   | Universal Slave Driver (USD)                                                         |

### Sync Hardware

**Synchronization Peripheral**
AVoption XL requires a Universal Slave Driver (USD).

**Sync Source**
For accurate synchronization during capture and playback, a house sync source or black burst generator is required.
**Audio** AVoption XL can store audio data to multiple hard drives. You should allocate audio tracks to different hard drives manually. “Round robin” disk allocation is not recommended in a system that includes video drives.

Both of these options are covered in detail in the *Pro Tools Reference Guide*.

**Video** AVoption XL can capture a contiguous video track to multiple hard disks. This is useful if the length of your video session exceeds the storage space available on a single drive. For example, 26 minutes of video material, using 3:1 compression, requires approximately 11.1 GB of storage space. To store this much video, you need two 9 GB hard drives.

**SCSI Hardware and Drives with Video Compression Level 2:1 or 1:1**

If you are using 2:1 or 1:1 video compression, your system requires two SCSI accelerators: the ATTO EPCI-UL2D LVD accelerator, and the ATTO EPCI-DC or Digidesign SCSI 64. In this scenario, video drives are connected to the EPCI-UL2D, and audio drives are connected to the EPCI-DC or SCSI 64. Or, two EPCI-DC’s may be used for this scenario.

**Striped Drive Requirements**

Striped drives are configured so that multiple hard drives behave as if they are one hard drive. This makes higher data throughput possible. 4-way striped drives (4 drives acting as one) are required when capturing, importing, or playing uncompressed (1:1) video. 2-way striped drives (2 drives acting as one) are required when capturing, importing, or playing 2:1 compressed video.

2-way striped drives should be connected in pairs to the EPCI-UL2D accelerator, with 1 drive connected to each channel.

4-way striped drives should be connected in pairs to the EPCI-UL2D accelerator, with 2 or more (in even amounts) drives connected to each channel.

⚠️ *Pro Tools and AVoption XL do not support striped audio drives.*
This chapter discusses the installation of AVoption software and hardware.

Installing a New AVoption System

If you do not already have currently supported Pro Tools TDM hardware installed, you must install AVoption as a new system.

To install a new AVoption system:

1. Install Pro Tools software using the Pro Tools Installer CD-ROM. The first time you launch Pro Tools, you are prompted to enter your authorization code, which is included in your TDM Software Installation Guide.

2. Install AVoption software. See “Installing AVoption Software” on page 12.

3. Install Pro Tools and AVoption hardware.
   - Determine the proper PCI slots for your installation. See Appendix A, “Slot Configurations for AVoption.”
   - Install Pro Tools hardware using the instructions in the TDM Installation Guide.
   - Install AVoption hardware. See “Installing AVoption Hardware” on page 13.

Installing AVoption as an Upgrade

If you have currently supported Pro Tools TDM hardware installed in your system, then you can install AVoption as an upgrade.

⚠️ You must have the latest version of Pro Tools (included in the AVoption package) installed before you install AVoption.

To install AVoption as an upgrade:

1. Install AVoption software. See “Installing AVoption Software” on page 12.

2. Install AVoption hardware. Determine the proper PCI slots for your installation using Appendix A, “Slot Configurations for AVoption.” You may need to rearrange previously installed Pro Tools hardware. To install AVoption hardware, see “Installing AVoption Hardware” on page 13.
Installing AVoption Software

AVoption includes the following software:

• Pro Tools Installer CD-ROM
• AVoption Installer CD-ROM
• AVoption Authorizer diskette

The Pro Tools Installer CD-ROM is provided in case you need to update your Pro Tools to the latest version. AVoption requires Pro Tools 5.0 or later. Owners of Pro Tools versions earlier than 5.0 will need to contact Customer Service for upgrade information.

AVoption is copy protected with a key disk. After you install the software from CD-ROM, the Authorizer diskette permits you to authorize and use a single copy of AVoption.

AVoption software is installed in a specific location in your System Folder, and should not be moved or altered. The Authorizer diskette permits you to reclaim authorization from your hard drive if you want to install AVoption on a different hard drive, or if you want to re-initialize or format your drive.

To install AVoption software:

1. Insert the Pro Tools Installer CD-ROM in your CD-ROM drive.
2. Follow the installation instructions to install AVoption.

To authorize or deauthorize AVoption:

1. Insert Authorizer diskette into floppy drive. (Pro Tools should NOT be launched during this process)
2. Click Authdeauthorizer in the pop-up window that appears.
3. Click Set-up Authorizer or Deauthorizer.
4. Choose Remove or Authorize (If you are removing an application and a”?” appears over the application icon, indicates that the diskette you inserted is not the one you originally used to authorize this application. You should see a gold key icon. If you continue through the de-authorization process with a “?” will deauthorize the application but not credit an authorization back to the diskette for your next installation.)
5. Select disk location and click Remove or Authorize.
6. Quit.

Installing FilmFrame

FilmFrame is optional, and copy protected with a key disk. If you purchase this option, you will receive a FilmFrame Authorizer diskette that permits you to authorize and use this option.

To authorize FilmFrame:

• Insert the Authorizer diskette into your floppy drive, and authorize FilmFrame.
Installing AVoption Hardware

AVoption PCI Slot Configurations
To install your AVoption hardware, first determine the PCI slots where you will install the hardware. For detailed information, see Appendix A, “Slot Configurations for AVoption.”

Audio Hardware
Refer to the TDM Hardware Installation Guide for audio hardware installation information. You may be required to move hardware that is already installed to new PCI slot locations in your computer or expansion chassis, based on the information in Appendix A, “Slot Configurations for AVoption.”

Installing AVoption Video Hardware
To install AVoption video hardware:
1. Unplug and open your Macintosh computer or your Magma expansion chassis according to the instructions included with it.
2. Release any static electricity by touching the power supply of the CPU, or another grounded item.
3. Remove the ABVB card from the antistatic bag, being careful to handle it only by the edges.
4. Line up the ABVB card with the installation slot, and slide the card gently into place so the PCI connector is lined up with the PCI slot.
5. Press down firmly on the card with even pressure. The connector should click into place in the PCI slot.
6. Repeat this process for the Janus Advanced JPEG card, making sure that you place it in the proper slot.
7 Attach the ribbon cable from the ABVB board to the connector on top of the Janus Advanced JPEG card by aligning the cable end with the connector, and gently pressing it onto the card until it clicks into place.

8 Close the computer or expansion chassis.
Chapter 4: Installing AVoption

Flashing SCSI ROM with ATTO ExpressPro-Tools

ExpressPro-Tools is supplied with Pro Tools 5.1 and every ATTO SCSI card, and allows you to flash the ROM on the SCSI card. Digidesign strongly recommends that the firmware be set on SCSI channels where audio storage is connected as follows:

1. Launch ExpressPro-Tools after booting your system and mounting all drives.
2. Double-click Media Drive.
3. From the Sync Rate pop-up menu, select “20 (10)” (20 MB/sec at 10 MHz).
4. Click “Apply to All” (sets the card for all drive IDs on that bus).
5. Repeat if necessary for the other bus.
6. Quit ExpressPro-Tools.
7. Restart your computer.

These settings are optimized for the size and frequency of SCSI transactions demanded by Pro Tools.

Initializing Hard Drives

The following is hard drive initialization information for three different scenarios: Pro Tools with no interchange, Avid to Pro Tools, and Pro Tools to Avid.

📖 Pro Tools and AVoption do not support striped audio drives.

Pro Tools with No Interchange

In installations where Pro Tools will not be routinely sharing projects with Avid Media Composer systems, ExpressPro-Tools from ATTO (provided with Pro Tools 5.1) should be used to initialize all audio and video drives. Both HFS and HFS+ file systems are supported for audio drives. Only HFS is supported for video drives (HFS+ has not been fully tested with video drives).

Avid to Pro Tools

For projects originating on an Avid Picture Authoring system, such as Media Composer, a single HFS drive initialized with either ADU 2.1 or later is supported. This drive may contain video or audio media files. Pro Tools with AVoption supports playback of audio and video tracks from a single drive, as long as track count does not exceed one stream of AVR77 and a maximum of eight audio tracks. When this drive is used in a Pro Tools session, additional audio tracks (beyond those imported from the Avid workstation) should not be added, for bandwidth reasons.

Drives initialized by Avid Drive Utility 2.1 or later as 2-way or 4-way are supported in this scenario. It is recommended that drives be added to the SCSI channel dedicated for video to balance demands on the SCSI system. Note that Pro Tools can recognize a maximum seven drives per SCSI channel.
**Pro Tools to Avid**

When a drive is being sent from a Pro Tools system to an Avid picture workstation, the drive should be initialized as HFS using ExpressProTools. When an Avid system is inheriting files from Pro Tools, a “finder copy” of these files may be necessary to transfer them from the Pro Tools drive to an Avid/AU2 initialized drive.

If a drive is sent from a Pro Tools system to an Avid workstation so that files can be consolidated and copied to that drive for use on Pro Tools, the same procedure is required. The drive should be initialized as HFS in ExpressProTools before being mounted on the Avid workstation.

**Media Management**

It is recommend that you dedicate one SCSI channel to audio drives and one SCSI channel to video drives. Doing this will help you to keep the data bandwidth balanced on your system (and avoid the necessity of constantly moving files around to consolidate bandwidth).

If your Pro Tools system is mounting an interchange drive originated by an Avid picture workstation, it is recommended that this interchange drive be installed on the SCSI bus dedicated to video data.

If your Pro Tools system receives an ADU2 drive with data from an Avid picture workstation, it recommended that you do not record additional audio files or tracks onto this drive.

**AVoption Video Connections**

**The ABVB Video Cable**

AVoption includes a cable that provides nine coaxial video connections to connect video and sync components of your system to the ABVB card.

---

**AVoption Video Connector Cable**

**To connect the ABVB cable to the ABVB card:**

1. Remove the ABVB cable from the protective plastic bag.
2. Connect the single connector end to the matching connector on the ABVB card.
3. Tighten the screws to lock the cable in place.

**Video Connectors on the ABVB Cable**

**GL IN** This “Gen Lock” connector is used to connect the ABVB card to an external reference video (black burst) source.

**CV OUT** This connector provides Composite Video out. You can use this output to connect an NTSC or PAL video monitor for video viewing. You can also connect this output to a composite input on your VTR.
Many NTSC video monitors include outputs that recreate a video input signal. You can connect the CV OUT from the ABVB to an NTSC monitor, then connect an output from the monitor to your VTR to record from AVoption.

**Y OUT, B-Y OUT, R-Y OUT** These connectors provide Component (RGB) Video outputs. You can use these to connect a video reference monitor or VTR that has Component Video inputs.

**CV IN** This input is used to get Composite Video from an external source into AVoption. Connect this to your video source. This connector can also be used in a video loop with the USD. The output of your VTR can be connected to the Video In connector on the USD, then the Video Out connector on the USD can be connected to this CV IN cable. You might use this connection to “window burn” with the USD.

**Y IN, B-Y IN, R-Y IN** These inputs are used to get Component Video signals from an external source into AVoption.

**To connect a BNC connector:**
- Slide the end of the BNC connector over the matching BNC connection, and twist the BNC connector clockwise until it locks into place.

**To remove a BNC connector:**
- Grip the BNC connector you want to remove and twist it counter-clockwise until it comes loose.

---

**USD Connections**

The following illustrations show USD connections. The *Universal Slave Driver User’s Guide* provides more specific information about this peripheral.

**Connecting House Sync or Black Burst**

In most AVoption setups, three black burst or “house sync” connections are required:
- To VIDEO REF in on the USD
- To a video input on your VTR (a video reference input if available)
- To the GL IN connector from the ABVB cable

Read the documentation for your black burst generator for more information.
Connecting a VTR

A VTR can be used to provide video input and to record video output from AVoption. In most situations, there are three connections you need to make:

• Connect a black burst or house sync output to a video input on your VTR (preferably a reference video input).

• Connect the ABVB cable’s CV IN and/or Component IN connectors to the corresponding outputs on your VTR.

• Connect the ABVB cable’s CV OUT and/or Component OUT connectors to the corresponding inputs on your VTR.

– or –

• Connect the ABVB cable’s CV OUT and/or Component OUT connectors to the corresponding input on an NTSC or PAL video monitor, then connect the outputs from this monitor to corresponding inputs on your VTR.

Connecting an External Video Reference Monitor

To connect an external NTSC or PAL video reference monitor, use the ABVB cable’s Composite or Component Video outputs.

Centralized Video Switching and Routing

Many professional facilities have centralized video switching and routing systems. These systems can be used to route AVoption’s inputs and outputs to flexible input sources and output destinations.

Configuring AVoption with a Single VGA Monitor

If you plan to run your Pro Tools AVoption system with only one VGA monitor, you will need to connect it to the Macintosh video card and designate it as the system startup monitor.

If the ABVB VGA output has defaulted to being the system startup monitor, you will need to perform the following procedure.

To set the VGA monitor as the startup monitor:

1. Connect your monitor temporarily to the ABVB VGA output.

2. Choose Monitors & Sound Control Panel > Identify Monitors.

3. Drag the Menu Bar across the top of the monitor icon from the ABVB monitor icon to the Macintosh monitor icon.

4. Drag the Macintosh icon from the middle of the ABVB monitor icon to the Macintosh monitor icon.

5. Restart your computer, with your VGA monitor connected to your Macintosh VGA output. The monitor will now appear as the system startup monitor.

Note that the steps above may be necessary when you first install AVoption, as well as after any time you zap the P RAM of your computer.
Set Color Depth to Millions

Since the VGA output on ABVB cannot be disabled, you will always see two monitors represented in the Monitors & Sound Control Panel (even if you have only one monitor connected to the Macintosh). As a result, when launching Pro Tools, you may receive the error message, “Video engine requires ABVB monitor to be set to millions of colors in order to load.”

To avoid this error message, set the Color Depth to “Millions” in the Monitor Control Panel.

ABVB’s VGA Output

The ABVB card includes a VGA monitor output, which can be used to drive a second VGA monitor. This second monitor is used to display the Pro Tools Movie window (see “Window Playback” on page 44), without taxing the resources of the Macintosh PCI bus.

To reduce PCI bus traffic, and avoid system performance errors, you should display only the Movie window on the ABVB monitor. Particularly problematic is placing windows partially on both monitors.

Configuring Two Monitors

When using two VGA monitors with AVoption, you must specify Macintosh monitor as the system startup monitor.

To the default monitor:

1. Choose Monitors & Sound Control Panel > Identify Monitors.
2. Drag the Menu Bar across the top of the monitor icon to the correct monitor icon.
3. Drag the Macintosh icon in the middle of the monitor icon to the correct monitor icon.
4. Next time you restart your computer, the new monitor assignments will take effect.

Using NTSC and PAL

When switching between NTSC and PAL formats, settings must be changed in three places:

- In the Pro Tools Session Setup window, select the correct frame rate (25, 29.97 DF or NDF).
- The USD must be set (and locked) to the respective format (PAL or NTSC).
- If you are going to capture video with AVoption, set the Movie Track to the respective format (PAL or NTSC). This setting can be modified when the Movie Track is armed for record. The Pal/NTSC format pop-up panel is available in the I/O panel on the Movie Track.

To see the Pal/NTSC format pop-up panel:

- Select Display > Edit Window Shows > I/O View.
Sample AVoption Setup
Diagrams

Sample ABVB video setup
Video connections for component video, black burst, and external monitor
chapter 5

Installing AVoption XL

This chapter discusses the installation of AVoption XL software and hardware.

Installing a New AVoption XL System

If you do not already have currently supported Pro Tools hardware installed, you must install AVoption XL as a new system.

To install a new AVoption XL system:

1. Install Pro Tools software using the Pro Tools Installer CD-ROM. The first time you launch Pro Tools, you are prompted to enter a authorization number, which is included in your TDM Software Installation Guide.


3. Install Pro Tools and AVoption XL hardware.
   - Determine the proper PCI slots for your installation. See Appendix B, “Slot Configurations for AVoption XL.”
   - Install Pro Tools hardware using the instructions in your Pro Tools Hardware Installation Guide.
   - Install AVoption XL hardware. See “Installing AVoption XL Hardware” on page 24.

Installing AVoption XL as an Upgrade

If you have currently supported Pro Tools TDM hardware installed in your system, then you can install AVoption XL as an upgrade.

⚠️ You must have the latest version of Pro Tools (included in the AVoption XL package) installed before you install AVoption XL.

To install AVoption XL as an upgrade:

1. Install AVoption XL software. See “Installing AVoption XL Software” on page 24.

2. Install AVoption XL hardware. Determine the proper PCI slots for your installation using Appendix B, “Slot Configurations for AVoption XL.” You may need to rearrange Pro Tools or other cards that are already installed. To install the AVoption XL hardware, see “Installing AVoption XL Hardware” on page 24.
Installing AVoption XL

Software

AVoption XL includes the following software:
• Pro Tools Installer CD-ROM
• AVoption XL Authorizer floppy disk

AVoption XL is copy protected with a key disk system. After you install the software from CD-ROM, the Authorizer diskette permits you to authorize and use a single copy of AVoption XL.

AVoption XL software is installed in a specific location in your System Folder, and should not be moved or altered. The Authorizer diskette permits you to reclaim authorization from your hard drive if you want to install AVoption XL on a different hard drive, or if you want to reinitialize or format your drive.

To install AVoption XL software:

1. Insert the Pro Tools Installer CD-ROM in your CD-ROM drive.
2. Follow the installation instructions to install AVoption XL.

To authorize or deauthorize AVoption XL:

1. Insert Authorizer diskette into floppy drive. (Pro Tools should NOT be launched during this process)
2. Click Authdeauthorizer in the pop-up window that appears.
3. Click Set-up Authorizer or Deauthorizer.
4. Choose Remove or Authorize (If you are removing an application and a “?” appears over the application icon, indicates that the diskette you inserted is not the one you originally used to authorize this application. You should see a gold key icon. If you continue through the deauthorization process with a “?” will deauthorize the application but not credit an authorization back to the diskette for your next installation.)
5. Select disk location and click Remove or Authorize.
6. Quit.

Installing AVoption XL

Hardware

AVoption XL PCI Slot Configurations

To install your AVoption XL hardware, first determine the PCI slots where you will install the hardware. For detailed information, see Appendix B, “Slot Configurations for AVoption XL.”

Audio Hardware

Refer to the TDM Hardware Installation Guide for audio hardware installation information. You may be required to move hardware that is already installed to new PCI slot locations in your computer or expansion chassis, based on the information in Appendix B, “Slot Configurations for AVoption XL.”
Installing AVoption XL Video Hardware

To install AVoption XL video hardware:

1. Unplug and open your Magma Expansion Chassis according to the instructions included with it.

2. Release any static electricity by touching the power supply of the chassis, or another grounded item.

3. Remove the Digital Media Board from the anti-static bag, being careful to handle it only by the edges.

4. Line up the Digital Media Board with the installation slot, and slide the card into place gently so the PCI connector is lined up with the PCI slot.

5. Press down firmly on the card with even pressure. The connector should click into place in the PCI slot.

6. Close the computer or expansion chassis.

7. Attach the connector cable from the Digital Media Board (connector labeled M) to the Computer connector on the Meridien I/O Box.

Connecting the Digital Media Board to the Breakout Box
Installing the ATTO EPCI-UL2D SCSI Accelerator

To install the ATTO EPCI-UL2D SCSI Accelerator:

1. Unplug and open your expansion chassis according to the instructions included with it.
2. Release any static electricity by touching the power supply, or another grounded item.
3. Remove the ATTO card from the antistatic bag, being careful to handle it only by the edges.
4. Line up the ATTO card with the installation slot, and slide the card into place gently so the PCI connector is aligned with the PCI slot.
5. Press down firmly on the card with even pressure. The connector should click into place in the PCI slot.
6. Fasten the card in place using the included screw to attach the card bracket to the computer mounting bracket.

Flashing SCSI ROM with ATTO ExpressProTools

ExpressPro-Tools is supplied with Pro Tools 5.1 and every ATTO SCSI card, and allows you to flash the ROM on the SCSI card. Digidesign strongly recommends that the firmware be set on SCSI channels where audio storage is connected as follows:

1. Launch ExpressPro-Tools after booting your system and mounting all drives.
2. Double-click Media Drive.
3. From the Sync Rate pop-up menu, select “20 (10)” (20 MB/sec at 10 MHz).
4. Click “Apply to All” (sets the card for all drive IDs on that bus).
5. Repeat if necessary for the other bus.
6. Quit ExpressPro-Tools.
7. Restart your computer.

These settings are optimized for the size and frequency of SCSI transactions demanded by Pro Tools. You do not need to apply these settings to the second SCSI card if one is installed for video media with AVoption XL.

Initializing Hard Drives

The following is hard drive initialization information for three different scenarios: Pro Tools with no interchange, Avid to Pro Tools, and Pro Tools to Avid.

⚠️ Pro Tools and AVoption XL do not support striped audio drives.
Pro Tools with No Interchange

In installations where Pro Tools will not be routinely sharing projects with Avid Media Composer systems, ExpressPro-Tools from ATTO (provided with Pro Tools 5.1) should be used to initialize all audio and video drives. Both HFS and HFS+ file systems are supported for audio drives. Only HFS is supported for video drives (HFS+ has not been fully tested with video drives).

Special Configuration Requirements

When you want compression levels of 2:1 or 1:1 (uncompressed), an additional ATTO UL2D or EPCI-DC SCSI accelerator is required for video storage. With the UL2D configuration, a 2-way stripe set across both SCSI channels is required for 2:1 capability, a 4-way stripe across both channels is required for 1:1 (uncompressed) capability. It is not necessary to use this configuration if you want compression of 3:1 or higher, or when an EPCI-DC SCSI accelerator is used for video storage.

To install:

1. Connect the drives across the two UL2D SCSI channels.
2. Select and create your stripe set using the ATTO ExpressRAID software (optional from ATTO).
3. Initialize all audio drives using ATTO ExpressPro-Tools.

⚠️ Do not use ExpressRAID to initialize your audio drives. ExpressRAID is not supported with audio drives.

Avid to Pro Tools

For projects originating on an Avid Picture Authoring system, such as Media Composer, a single HFS drive initialized with either ADU 2.1 or later is supported. This drive may contain video or audio media files. Pro Tools with AVoption XL supports playback of audio and video tracks from a single drive, as long as track count does not exceed one stream of video (at a compression of 3:1 or higher) and a maximum of eight audio tracks.

When this drive is used in a Pro Tools session, additional audio tracks (beyond those imported from the Avid workstation) should not be added, for bandwidth reasons.

Drives initialized by Avid Drive Utility 2.1 or later as 2-way or 4-way are supported in this scenario. It is recommended that drives be added to the SCSI channel dedicated for video to balance demands on the SCSI system. Note that Pro Tools can only recognize a maximum seven drives per SCSI channel.

Pro Tools to Avid

When a drive is being sent from a Pro Tools system to an Avid picture workstation, the drive should be initialized as HFS using ExpressPro-Tools. When an Avid system is inheriting files from Pro Tools, a “finder copy” of these files may be necessary to transfer them from the Pro Tools drive to an Avid/AU2 initialized drive.

If a drive is sent from a Pro Tools system to an Avid workstation so that files can be consolidated and copied to that drive for use on Pro Tools, the same procedure is required. The drive should be initialized as HFS in ExpressPro-Tools before being mounted on the Avid workstation.
Media Management

It is recommended that you dedicate one SCSI channel to audio drives and one SCSI channel to video drives. This configuration is adequate for AVoption XL with compression levels of 3:1 or higher.

If you want compression levels of 2:1 or 1:1 (uncompressed), an additional separate dual-channel SCSI card is required for video drives. These configurations require that striped drives are split across the SCSI buses.

If your Pro Tools system is mounting an interchange drive originated by an Avid picture workstation, it is recommended that this interchange drive be installed on the SCSI bus dedicated to video data.

If your Pro Tools system receives an ADU2 drive with data from an Avid picture workstation, it is recommended that you do not record additional audio files or tracks onto this drive.

AVoption XL Video Connections

The following video I/O capabilities are available with the Meridien I/O Box:

- Inputs for composite, component (Y, R-Y, B-Y), S-Video, and (optional) SDI.
- Outputs for composite, component (Y, R-Y, B-Y), S-Video, and (optional) SDI.
- Video Ref input to allow the video to be locked to an external source such as house sync or a black burst generator.

Note that only one video input source can be used at a time. For more information, see “Recording Video” on page 37.

⚠️ The Meridien I/O Box can only output from either S-Video or Component outputs. You must set this option in your Movie Track. See “Setting S-Video or Component Output” on page 36 for instructions.
Meridien I/O Box

The following sections provide figures and tables that describe the function of the Meridien I/O Box video I/O.

Meridien I/O Box Front Panel Indicators

The front panel of the Meridien I/O Box (see Figure 1) has six indicators and a power switch. When you turn on the Meridien I/O Box, the indicators turn on and off as it goes through a power-on self-test (POST). After the POST, the POWER indicator remains lit.

Some indicators do not light, or do not indicate correctly, when used with AVoption XL (see illustration). To determine this information, use the indicators on your USD, or your Session Setup window.

Figure 1. Meridien I/O Box front panel
Video I/O Connectors

Figure 2. Meridien I/O Box rear panel showing video connectors

Table 1. Video I/O Board Identifiers

<table>
<thead>
<tr>
<th>Number</th>
<th>Label</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>COMPONENT Y IN</td>
<td>Video Y component input, BNC connector. Connects to analog video output of decks.</td>
</tr>
<tr>
<td>2</td>
<td>COMPONENT R-Y IN</td>
<td>Video R-Y component input, BNC connector. Connects to analog video output of decks.</td>
</tr>
<tr>
<td>3</td>
<td>COMPONENT B-Y IN</td>
<td>Video B-Y component input, BNC connector. Connects to analog video output of decks.</td>
</tr>
<tr>
<td>4</td>
<td>COMPONENT Y OUT</td>
<td>Video Y component (Betacam) output, BNC connector. Connects to analog video input of decks.</td>
</tr>
<tr>
<td>5</td>
<td>COMPONENT R-Y OUT</td>
<td>Video R-Y component (Betacam) output, BNC connector. Connects to analog video input of decks.</td>
</tr>
<tr>
<td>6</td>
<td>COMPONENT B-Y OUT</td>
<td>Video B-Y component (Betacam) output, BNC connector. Connects to analog video input of decks.</td>
</tr>
<tr>
<td>7</td>
<td>SDI IN (optional)</td>
<td>Serial digital input, BNC connector. Connects to a serial digital output from a digital video source.</td>
</tr>
<tr>
<td>8</td>
<td>SDI OUT1 (optional)</td>
<td>Serial digital output number 1, BNC connector. Connects to VTR input, a video monitor, or other serial digital device.</td>
</tr>
</tbody>
</table>
### Table 1. Video I/O Board Identifiers (Continued)

<table>
<thead>
<tr>
<th>Number</th>
<th>Label</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>SDI OUT2 (optional)</td>
<td>Serial digital output number 2, BNC connector. Connects to VTR input, a video monitor, or other serial digital device.</td>
</tr>
<tr>
<td>10</td>
<td>SDI OUT3 (optional)</td>
<td>Serial digital output number 3, BNC connector. Connects to VTR input, a video monitor, or other serial digital device.</td>
</tr>
<tr>
<td>11</td>
<td>SYSTEM</td>
<td>Audio and video I/O connector from the system interface board.</td>
</tr>
<tr>
<td>12</td>
<td>LTC OUT</td>
<td>Sends LTC time code out (not used with AVoption XL).</td>
</tr>
<tr>
<td>13</td>
<td>LTC IN</td>
<td>Brings LTC time code in (not used with AVoption XL).</td>
</tr>
<tr>
<td>14</td>
<td>SLAVE CLOCK OUT</td>
<td>Clock output, BNC connector (not used with AVoption XL)</td>
</tr>
<tr>
<td>15</td>
<td>S-VIDEO OUT</td>
<td>Super-video output, 4-pin connector. Connects to analog video input of decks.</td>
</tr>
<tr>
<td>16</td>
<td>COMPOSITE OUT3</td>
<td>Composite video output, BNC connector. Connects to analog video input of decks or monitor.</td>
</tr>
<tr>
<td>17</td>
<td>COMPOSITE OUT2</td>
<td>Composite video output, BNC connector. Connects to analog video input of decks or monitor.</td>
</tr>
<tr>
<td>18</td>
<td>COMPOSITE OUT1</td>
<td>Composite video output, BNC connector. Connects to analog video input of decks or monitor.</td>
</tr>
<tr>
<td>19</td>
<td>S-VIDEO IN</td>
<td>Super-video input, 4-pin connector. Connects to analog video output of decks.</td>
</tr>
<tr>
<td>20</td>
<td>COMPOSITE IN</td>
<td>Composite video input, BNC connector. Connects to analog video output of decks.</td>
</tr>
<tr>
<td>21</td>
<td>Video Reference (REF)</td>
<td>Black burst or house sync input, BNC connector. Synchronizes the system with the global clock source provided by the house sync or black burst generator.</td>
</tr>
</tbody>
</table>
**USD Connections**

The following illustrations show USD connections. The *Universal Slave Driver User’s Guide* provides more specific information about this peripheral.

**Connecting House Sync or Black Burst**

In most AVoption XL setups, three black burst or “house sync” connections are required:

- To VIDEO REF in on the USD
- To a video input on your VTR (a video reference input if available)
- To the VIDEO REF connector on the Meridien I/O Box

Read the documentation for your black burst generator for more information.

**Connecting a VTR**

A VTR can be used to provide video input and to record video output from AVoption XL. In most situations, there are three connections you need to make:

- Connect a black burst or house sync output to a video input on your VTR (preferably a reference video input).
- Connect the Meridien I/O Box Composite IN, Component IN, S-Video IN, or SDI IN connectors to the corresponding output or outputs on your VTR.
- Connect the Meridien I/O Box Composite OUT, Component OUT, S-Video OUT, or SDI OUT connectors to the corresponding inputs on your VTR.

  - or -

- Connect the Meridien I/O Box Composite OUT or Component OUT connectors to the corresponding input on an NTSC or PAL video monitor, then connect the outputs from this monitor to corresponding inputs on your VTR.

⚠️ The Meridien I/O Box can only output from either S-Video or Component outputs (S-Video is a type of Component output and you must choose which component output you want you to use). You must set this option in your Movie track. See “Setting S-Video or Component Output” on page 36 for instructions.
**Connecting an External Video Reference Monitor**

Connect an external NTSC or PAL video reference monitor to a Composite, Component, S-Video, or SDI output.

**Centralized Video Switching and Routing**

Many professional facilities have centralized video switching and routing systems. These systems can be used to route AVoption XL’s inputs and outputs to flexible input sources and output destinations.

**Using NTSC and PAL**

When switching between NTSC and PAL formats, settings must be changed in three places:

- In the Pro Tools Session Setup window, select the correct frame rate (25, 29.97 DF or NDF).
- The USD must be set (and locked) to the respective format (PAL or NTSC).
- If you are going to capture video with AVoption XL, set the Movie Track to the respective format (PAL or NTSC). This setting can be modified when the Movie Track is armed for record. The Pal/NTSC format pop-up panel is available in the I/O panel on the Movie Track.

To see the Pal/NTSC format pop-up panel:

- Select Display > Edit Window Shows > I/O View.
You can *capture* video files by actually recording the video in through the inputs on your ABVB connector cable (AVoption) or the inputs on your Meridien I/O Box (AVoption XL). You can also *add* files created in a compatible Avid video editing and composition program, or previously captured in Pro Tools.

### The Movie Track

The Movie track holds the video clips you capture or add into Pro Tools. A Pro Tools session with AVoption or AVoption XL can only contain one Movie track.

To select record drives or choose an AVR or compression ratio, select Display > Edit Window Shows I/O view.

To create a new Movie track:

- Choose Movie > New Movie Track.

The new, empty track appears in the Edit window.
To name the Movie track:
1. Double-click the Track Name button to open the Name and Comments dialog.
2. Type a name (and any optional comments), then click OK.

To delete the Movie track:
1. Select the track by clicking the Track Name button in the Edit window.
2. Choose File > Delete Selected Tracks.

To clear all video from the Movie track:
1. Choose Movie > Clear Movie Track.

You cannot change names of clips after they have been added or recorded. When added, clips retain the name they were given by the original workstation (often an Avid editing system). When recorded in Pro Tools, the clip name is derived from the Movie track's name. You can change the clip name by renaming the Movie track.

**Setting S-Video or Component Output**

(AVoption XL Only)

The Meridien I/O Box can output from either the S-Video or Component outputs. Composite out is always active regardless of whether S-video or component is selected. This choice must be made in the software. Once the choice is made in the software, it is then echoed in the physical connections you use to output signals.

**Movie Track Options**

The Movie track can be viewed in frames or in blocks. Frames allow you to see an overview of the actual video content in a session. Blocks allow you to see where clips begin and end, and the names of clips.

**Frames**

In Frames mode, video data is displayed as pictures in the Movie track. These pictures are computed based on the video image, and scale according to your track zoom and height settings. They do not provide a frame-accurate reference, but allow you to easily find a scene or sequence in the Movie track.

**Blocks**

Blocks mode displays the Movie track as blocks of compositional data. Blocks are outlined wherever clip boundaries exist. These block names indicate both the boundaries for clips defined in
a video editing system and separate clips recorded into Pro Tools. Names from the original clips are retained, and new names are given to newly recorded material. For example, two clips edited together without any transitions or effects, and named “House Ext” and “House Int,” will appear as two blocks bordering each other with those names.

In Blocks mode, you can place the cursor on the Movie track, then press Tab to move to the next video edit in the track.

**To set the view for the Movie track:**

- On the Movie track, select Frames or Blocks from the View Options pop-up menu.

---

**Recording Video**

You can record multiple video clips to multiple locations on a single Movie track.

**To set video recording options:**

1. To record video, you will first need a Movie track. You can use the existing one, or if necessary, create a new one.

2. Select a video format by clicking the Track options button (see Figure 3 and Figure 4), then selecting Video Format. You can select NTSC or PAL format.

3. To select record drives or choose an AVR or compression ratio, select Display > Edit Window Shows I/O view.

4. Select the video input you are using by clicking the Record options button, then selecting Video Input. You can select Component or Composite input (AVoption and AVoption XL), or S-Video or SDI (AVoption XL only).

5. Set the compression level for the video capture from the Compression Level pop-up menu.

6. Select the target hard drive volumes for the video capture. Target volumes capture video in order, from the first (top) to the last (bottom). In the following illustration, Video-0 captures video first, followed by Video-1, then Video-3.
To record video:

1. Use your cursor to mark the point from where you want to start recording, or to select a range of time for the recording. You can make this selection on a Timebase Ruler or on a track. If you make this selection on a track, make sure that Edit and Timeline selections are linked.

2. Record enable the track by clicking the Record Enable button.

3. Click the Record button in the Transport window to enable recording.

4. Start playing the video source.

5. Click Play in the Transport window to begin recording.

6. Click Stop in the Transport window to stop recording.

⚠️ Note that if there are already clips on the Movie track, and you record over them, the overwritten material will be removed from the Movie track (although it will still remain intact in its original storage location). You can Undo Capture Clip and restore the original clips. Refer to “Undo/Redo for Video Editing Commands” on page 42 for more information.

Command+period (.) will abort a clip capture in progress and restore the Movie track to the original clips.

MachineControl

You can use Digidesign’s MachineControl software to remotely control your external video deck in sync with your Pro Tools capture. MachineControl is optional software. Contact your dealer for more information.

Blocks mode is recommended when recording to the Movie track with MachineControl.

Timebase Correction

Most professional video decks have built-in timebase correction. To find out whether or not your video deck has built-in timebase correction, refer to the manufacturer’s documentation.

AVoption XL requires that all sources be timebase corrected. AVoption allows you to capture video from sources that are not timebase corrected. However, it is recommended that you use timebase corrected sources whenever possible.

If you are manually capturing video in AVoption that is not timebase corrected, start playback of the video deck first to stabilize the signal. If your configuration does not feature timebase correction, make sure that your sync generator is connected to the external sync or reference video input on your video deck, and that the deck’s sync selector is set to “external sync” or “reference video.”

Capturing with Stationary Playhead

If you want to capture video with Scrolling Options set to “Continuous Scrolling with Playhead,” AVoption should always be set to Blocks mode (as opposed to Frames mode) to avoid performance errors.

Capturing and Approximate Time Left

The approximate record time left in the I/O View of the Movie track is an estimate. AVoption and AVoption XL use variable compression technologies, and record time varies based on the density of the material you are recording.
Due to these variables, the approximate record time left is intended to provide you a rough estimate and may not be an accurate reflection of your available record time.

The calculation of approximate record time left is a conservative estimate based on the highest data rate possible for that resolution. The approximation may vary by several minutes.

Pro Tools uses the approximate record time left value to allocate drive space before recording. Because of variables inherent to this estimation process, you may find that you have available record time left after you thought you had filled the drive.

The record time left is not approximate if you are capturing video at a compression rate of 1:1 (uncompressed) in AVoption XL. Since this video is uncompressed, it uses the same data rate, regardless of the image.

### Exporting Files from Avid Programs

If you already have a project that was created on an Avid video authoring system, you can export it to an OMF file so the material can be added into your AVoption or AVoption XL system. This exchange of data between systems is significantly faster and easier than other methods, such as laying-off to tape and re-digitizing. This section uses a Media Composer project as an example.

### DigiTranslator

DigiTranslator is included with your AVoption or AVoption XL package. Use DigiTranslator to convert OMF files containing video and audio into Pro Tools session files. You can also use it to export audio material from Pro Tools sessions to OMF files for import into other systems. Refer to your DigiTranslator documentation for more details.

### Multi-Streams and AVoption and AVoption XL

While some Avid systems support two simultaneous streams of real time video, AVoption and AVoption XL support only one stream. For this reason, it is necessary to make sure that all multi-stream transitions and effects are rendered in the Avid sequence before you export.

If you add a sequence into Pro Tools that includes multi-stream effects, AVoption will substitute black frames in their place.

AVoption does not require the entire sequence to be rendered into one continuous clip (often referred to as a “video mixdown” in Avid). AVoption and AVoption XL can add complex single-stream sequences as multiple clips.

### What to Export

When you export from your Avid software, you have two choices. You can export the audio and video from a project, or you can export the audio or video only.

#### Video and Audio

If your Media Composer project has video and audio in it, export both the video and the audio to the OMF file.

#### Video Only

If you have already started audio post production in Pro Tools and you want to replace the Movie track with a more recent version, or your Avid project has no audio in it, export the video.
only. Then, if the video in your project changes, you can export video only, then add that video into AVoption or AVoption XL to stay current with the project.

For more information, and specific workflows for add and export, see the DigiTranslator Guide (DigiTranslator is included in the AVoption and AVoption XL packages).

Preparing for Export in Media Composer

To prepare a Media Composer project for OMF export and use with AVoption or AVoption XL:
- Make sure all media for the project is online.
- Render all effects in advance. OMF export does not automatically render effects during the process, so if you want to see them, you must render effects before you export.

Exporting from Media Composer

To export a file from Media Composer:

1. Select the material to export by doing one of the following:
   - To select specific tracks in a clip or sequence, enable those tracks in the Track Selector panel, and disable all others.
   - To export part of a clip or sequence, mark IN and OUT points to export the marked range from a bin or monitor, and select Use Marks in the Export Settings dialog box. If you mark an IN and no OUT point, the system exports from the IN mark to the end of the clip or sequence.
   - To export the entire clip or sequence, deselect the options Use Enabled Tracks and Use Marks in the Export Settings dialog box, and make sure the topmost track in the project is monitored.
   - If using different drives to transport the project, consolidate the project.

2. Choose File > Export.

   ![Export File Type dialog in Media Composer]

   - Under Export File type, select OMFI composition.
   - If adding video and audio into an AVoption session, select Standard-AIFC and Video and Audio options.
   - If adding video only into AVoption, select Video Only.
   - Usually, you should export an OMF file that only refers to the audio and video files that already exist on the hard drives. For this reason, it is recommended that you do not export With Media.

3. Set the Version to OMFI 2.0.

4. When you finish setting export options, click OK.

5. Run DigiTranslator.
Adding Movie Files with AVoption and AVoption XL

With the Add Movie command, you can import several clips to a single Movie track, increasing your editing capabilities.

If there are already clips on the Movie track and you add over them, the overwritten material will be removed from the Movie track. You can undo and restore the original clips. Refer to “Undo/Redo for Video Editing Commands” on page 42 for more information.

Once you have OMF files for your project, you are ready to add them. If your OMF file is Video Only you can add it as the Movie track in AVoption or AVoption XL. If your OMF file has video and audio, you can use OMF Tool to create a Pro Tools session from the audio files, then add the Movie track separately.

You can use DigiTranslator to translate video and audio simultaneously. See your DigiTranslator documentation for details.

To create a Pro Tools session with OMF Tool:

1. Launch OMF Tool, and choose OMF Tool > Convert OMF to Pro Tools.
2. Select the OMF composition file.
3. Name the Pro Tools session, and choose Pro Tools 4 as the version to save.
4. Set all other options based on your session requirements, and click Save when you are done. The resulting file is a Pro Tools session. OMF Tool ignores the video information.

To open your session with AVoption or AVoption XL:

1. Choose File > Open Session.
2. Find the Pro Tools session created by OMF Tool, select it, and click Open.

To add a video into the Movie track:

1. With a session open, choose Movie > Add Movie.
2. Select the OMF file created by the Video Only or Video and Audio export, and click OK.

Importing Movies (QuickTime)

You can import a QuickTime movie to a Movie track. When you import a movie, it clears the Movie track of its contents and replaces it with the imported movie. Importing is only recommended if you want to import a QuickTime movie, since QuickTime movies take up the whole Movie track and cannot be edited with other clips. Adding movie clips is recommended for editing multiple clips (that are not QuickTime). See “Adding Movie Files with AVoption and AVoption XL” on page 41.

For more information on QuickTime movies and how to import them, see the Pro Tools Reference Guide.
Undo/Redo for Video Editing Commands

You can undo or redo the single most recent video editing command, including Add Movie, Clear Selection, Move Clip, Copy Clip, and Clip Capture. If there are already video clips on the Movie track, and you record or edit over them, the overwritten material is removed from the Movie track. You can undo the video editing command and restore the original clips.

Undo/Redo works only for the single most recent video editing command. You cannot undo/redo once a new video editing command has been performed or the session has been closed and reopened.

To undo the most recent video editing command:
• Choose Movie > Undo.

To redo the command, choose Movie > Redo.

If you have captured, added or moved a clip onto a pre-existing clip and consequently truncated it, Undo will also restore the trimmed clip to its original length.

Performance Guidelines

Virtually all testing for AVoption and AVoption XL was done with:
• A baseline of 32 tracks (of 24-bit/48k audio).
• One stream of the highest resolution of video data (record or playback) of which the product is capable (AVR77 for AVoption and 1:1—or uncompressed—for AVoption XL).

These test configurations generally included one drive for every 16 tracks of audio in addition to separate storage devices for video. One way to achieve higher track counts is to dedicate more drives to the audio tracks.

On a supported configuration, you should be able to easily achieve this performance baseline, even with a high degree of edit density on each track. The higher the edit density, the more heavily taxed the storage system.

You may find better results than this baseline, since Digidesign’s performance tests are designed to stress the storage subsystem more heavily than the average “real world” usage. You may be able to continuously record or play back 64 audio tracks and picture simultaneously.
Video plays back automatically when you play a session that includes a Movie track. There are several different options for viewing and synchronizing the video and audio tracks.

**Movie Online**

When the movie is online, the Movie track plays along with the audio session. The movie’s frame location is updated every time you place your cursor in a new location, and the Movie track is scrubbed along with the audio tracks. The Movie track is also updated whenever you drag or nudge an audio region or an automation breakpoint. The movie is online by default.

**Movie Offline**

If you temporarily do not want to view the movie or have the movie frame location updated, you can take the movie offline. This is useful if you are working with audio and do not need to see the video.

**To put the movie online:**
- Select Movie > Movie Online.

**To take the movie offline:**
- Deselect Movie > Movie Online.

The keyboard shortcut for Movie Online/Offline is Shift+Command+J.
**Playback Viewing Options**

Video can be viewed on a separate NTSC or PAL video monitor. Video can also be viewed in an on-screen window (AVoption only).

**Using a Playback Monitor with AVoption**

The ABVB video cable includes video outputs to connect an NTSC or PAL video monitor. You can connect a monitor that has component or composite video inputs.

The video card will display full-screen video on the playback monitor.

**To connect a playback monitor:**

- Connect the composite output or the component outputs from the ABVB cable to the proper input or inputs on the back of your video monitor.

**Using a Playback Monitor with AVoption XL**

The Meridien I/O Box includes video outputs to connect an NTSC or PAL video monitor. You can connect a monitor that has component, composite, S-Video, or SDI video inputs.

The video card will display full-screen video on the playback monitor.

**To connect a playback monitor:**

- Connect a composite output, the component outputs, the S-Video output, or and SDI output from the Meridien I/O Box to the proper input or inputs on the back of your video monitor.

**Window Playback**

(AVoption Only)

Select Windows > Show Movie Window to view the Movie track in a window on your computer screen. This window will display the video in real time. You can resize or move this window around your screen when playback is stopped.

The Movie window will give you the best performance when it is displayed on a monitor connected to the ABVB VGA monitor output. With a monitor connected to your Macintosh graphics accelerator, performance will not be optimal, and may not work at all.

⚠️ You cannot view the video input signal in a window. In order to view video input, you must connect an external monitor to the Composite or Component outputs of the ABVB card.
If the Movie window is partially blocked by another window on your screen, playback will slow or “stutter” as your computer’s CPU attempts to display the video.

Movie window size and position are saved with your session.

To show the Movie window:
- Choose Windows > Show Movie Window.

To resize the Movie window:
- When playback is stopped, click the lower right corner of the Movie window and drag to shrink or enlarge the window.

### Movie Aspect Ratio

(AVoption Only)

You can set the Movie window to automatically snap to one of two window aspect ratios (4:3 or 16:9), or to allow unconstrained resizing.

By constraining the aspect ratio, you can see a more accurate on-screen representation of the final video. Use 4:3 for video destined for television, and use 16:9 for wide screen film-format viewing.

To set the Movie window aspect ratio:
1. Choose Movie > Show Movie window.
2. Choose Movie > Movie Window Aspect Ratio.
3. Choose 4:3, 16:9, or unconstrained as the aspect ratio.

---

### Moving the Movie Track or Video Clips

You can use the Move Clip command to spot the entire Movie track, or individual video clips, to a new SMPTE frame location. When you move the Movie track, the whole track or sequence is moved to the new frame location you specify. When you move a clip, it is moved to the new location within the Movie track.

You cannot have multiple QuickTime clips on a Movie track.

If you move a clip in which a sync point was previously created, the sync point will maintain its position within the clip. For more information on understanding, creating, identifying and removing sync points, see the *Pro Tools Reference Guide*.

⚠️ **Note that if there are already clips on the Movie track, and you edit over them, the overwritten material will be removed from the Movie track. You can undo Move Clip and restore the original clips. For more information, see “Undo/Redo for Video Editing Commands” on page 42.**

To spot the entire Movie track to a new frame location:
1. Set the Main Timebase display to Time Code using the pop-up menu.

![Time Code Display](image)

2. Enable Spot mode by clicking the Spot button.
3 Shift-click the Movie track with the Grabber tool.

4 In the Spot dialog that appears, specify a new SMPTE frame number for the start of the Movie track. In this dialog, you can press plus or minus on the numeric keypad, enter a number, and press the Enter key to add or subtract that number of frames from the currently selected time field.

5 Click OK when you are done.

To spot a video clip to a new frame location:

1 Set the Main Timebase display to Time Code using the pop-up menu.

2 Enable Spot mode by clicking the Spot button.

3 Click the clip on the Movie track with the Grabber tool.

4 In the Spot dialog, specify a new SMPTE frame number for the start of the clip. In this dialog, you can press plus or minus on the numeric keypad, enter a number, and press the Enter key to add or subtract that number of frames from the currently selected time field.

5 Click OK when you are done.

Copying Video Clips

You can copy video clips to a new SMPTE frame location within the Movie track.

To copy a video clip to a new frame location:

1 Set the Main Timebase display to Time Code using the pop-up menu.

2 Enable Spot mode by clicking the Spot button.

3 Option-click the clip on the Movie track with the Grabber tool.

4 In the Spot dialog, specify a new SMPTE frame number for the start of the clip. In this dialog, you can press plus or minus on the numeric keypad, enter a number, and press the Enter key to add or subtract that number of frames from the currently selected time field.

5 Click OK when you are done.

Clearing Selected Video Clips

You can clear material from the Movie track.

To clear selection:

1 Drag with the Selector in the Movie track to select the material you want to clear. You can also double-click to select an entire existing video clip.

2 Choose Movie > Clear Selection.
Sync Points

Sync points are used when a point within a region must be aligned to the Grid or to a particular SMPTE or bar and beat location. This capability is important editing music and sound effects for video and film work.

Once you have a sync point identified, you can spot edit the clip based on that sync point. For more information on moving video clips, see “Moving the Movie Track or Video Clips” on page 45.

To identify a sync point:

1. Set the Edit mode to Spot mode.
2. With the Selector, click in the region at the point where you want to define the sync point.
3. Choose Edit > Identify Sync Point. A small down arrow appears at the bottom of the region, indicating the location of the sync point.

To remove a sync point, select the entire region with the sync point and choose Edit > Remove Sync Point.

For more information on sync points, see the *Pro Tools Reference Guide*.

Locking the Movie Track

If you want to permanently associate your video clips with a certain location on your Movie track, you can lock it in place so it will not be moved accidentally.

To lock the Movie track:

1. With the Grabber, select the Movie track.
2. Choose Edit > Lock Region/Unlock Region.

You can also lock the Movie track by triple-clicking in the Movie track (to select all clips) and pressing Command+L.

When the Movie track is locked, a small lock icon appears in the track, indicating that the Movie track has been locked and cannot be moved. If you attempt to move a locked region, you will receive an error message.

Once a Movie track is locked, you cannot Add video clips to it (without first unlocking it).

Locking the Movie track only prevents it from being moved. Recording still affects the clips in the Movie track.
This appendix documents slot configurations for AVoption systems, with and without expansion chassis.

**9500/9600 without Expansion Chassis**

<table>
<thead>
<tr>
<th>Slot</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Slot 1</td>
<td>Macintosh Monitor card</td>
</tr>
<tr>
<td>CPU Slot 2</td>
<td>d24 or MIX Core card</td>
</tr>
<tr>
<td>CPU Slot 3</td>
<td>MIX Farm or DSP Farm cards (if any)</td>
</tr>
<tr>
<td>CPU Slot 4</td>
<td>SCSI HBA</td>
</tr>
<tr>
<td>CPU Slot 5</td>
<td>Janus Advanced JPEG card</td>
</tr>
<tr>
<td>CPU Slot 6</td>
<td>ABVB card</td>
</tr>
</tbody>
</table>

⚠️ CPU speed of 300 MHz or higher recommended.
### 9500/9600 with 13-Slot Expansion Chassis

Pro Tools Expansion Chassis (serial numbers lower than NB0600100C)
Magma PCI-13-RX-400V
SBS DD2, 240–2–2, or 240–2–201

<table>
<thead>
<tr>
<th>Slot</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Slot 1</td>
<td>Empty</td>
</tr>
<tr>
<td>CPU Slot 2</td>
<td>Chassis Host card</td>
</tr>
<tr>
<td>CPU Slot 3</td>
<td>Macintosh Monitor card</td>
</tr>
<tr>
<td>CPU Slot 4</td>
<td>SCSI HBA</td>
</tr>
<tr>
<td>CPU Slot 5</td>
<td>Janus Advanced JPEG card</td>
</tr>
<tr>
<td>CPU Slot 6</td>
<td>ABVB card</td>
</tr>
<tr>
<td>Backplane Chassis Slot</td>
<td>Chassis Controller card</td>
</tr>
<tr>
<td>Chassis Slot 1</td>
<td>d24 or MIX Core card</td>
</tr>
<tr>
<td>Chassis Slots 2–10</td>
<td>Additional Pro Tools cards (9 maximum)</td>
</tr>
<tr>
<td>Chassis Slots 10–13</td>
<td>Empty</td>
</tr>
</tbody>
</table>

⚠️ **CPU speed of 300 MHz or higher recommended.**

⚠️ **Expansion chassis slots are numbered sequentially from left to right. These chassis require a supplemental cooling fan kit.**
### 9500/9600 with 7-Slot Expansion Chassis

SBS DD22–1 or 2101–00–2 (with IBM Bridge Chips)

<table>
<thead>
<tr>
<th>Slot</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Slot 1</td>
<td>Empty</td>
</tr>
<tr>
<td>CPU Slot 2</td>
<td>Chassis Host card</td>
</tr>
<tr>
<td>CPU Slot 3</td>
<td>Macintosh Monitor card</td>
</tr>
<tr>
<td>CPU Slot 4</td>
<td>SCSI HBA</td>
</tr>
<tr>
<td>CPU Slot 5</td>
<td>Janus Advanced JPEG card</td>
</tr>
<tr>
<td>CPU Slot 6</td>
<td>ABVB card</td>
</tr>
<tr>
<td>Backplane Chassis Slot</td>
<td>Chassis Controller card</td>
</tr>
<tr>
<td>Chassis Slot 1</td>
<td>d24 or MIX Core card</td>
</tr>
<tr>
<td>Chassis Slots 2–7</td>
<td>Additional Pro Tools cards (6 maximum)</td>
</tr>
</tbody>
</table>

⚠️ *CPU speed of 300 MHz or higher recommended.*

⚠️ *Expansion chassis slots are numbered sequentially from left to right. These chassis require a supplemental cooling fan kit.*
**Blue & White G3 with 13-Slot Expansion Chassis**

Pro Tools Expansion Chassis (serial numbers lower than NB0600100C)
Magma PCI–13–RX–400V

<table>
<thead>
<tr>
<th>Slot</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Slot 1</td>
<td>Chassis Host card</td>
</tr>
<tr>
<td>CPU Slot 2</td>
<td>Empty</td>
</tr>
<tr>
<td>CPU Slot 3</td>
<td>SCSI HBA</td>
</tr>
<tr>
<td>Backplane Chassis Slot</td>
<td>Chassis Controller card</td>
</tr>
<tr>
<td>Chassis Slot 1</td>
<td>ABVB card</td>
</tr>
<tr>
<td>Chassis Slot 2</td>
<td>Janus Advanced JPEG card</td>
</tr>
<tr>
<td>Chassis Slot 3</td>
<td>d24 or MIX Core card</td>
</tr>
<tr>
<td>Chassis Slots 4–12</td>
<td>Additional Pro Tools cards (9 maximum)</td>
</tr>
<tr>
<td>Chassis Slot 13</td>
<td>Empty</td>
</tr>
</tbody>
</table>

⚠️ *Expansion chassis slots are numbered sequentially from left to right. These chassis require a supplemental cooling fan kit.*
## G4 with 13-Slot Expansion Chassis

Pro Tools Expansion Chassis (serial numbers lower than NB0600100C)
Magma model PCI–13–RX–400V

<table>
<thead>
<tr>
<th>Slot</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Slot 1</td>
<td>SCSI HBA</td>
</tr>
<tr>
<td>CPU Slot 2</td>
<td>Chassis Host card</td>
</tr>
<tr>
<td>CPU Slot 3</td>
<td>Empty</td>
</tr>
<tr>
<td>Backplane Chassis Slot</td>
<td>Chassis Controller card</td>
</tr>
<tr>
<td>Chassis Slot 1</td>
<td>ABVB card</td>
</tr>
<tr>
<td>Chassis Slot 2</td>
<td>Janus Advanced JPEG card</td>
</tr>
<tr>
<td>Chassis Slot 3</td>
<td>d24 or MIX Core card</td>
</tr>
<tr>
<td>Chassis Slots 4–12</td>
<td>Additional Pro Tools cards (9 maximum)</td>
</tr>
<tr>
<td>Chassis Slot 13</td>
<td>Empty</td>
</tr>
</tbody>
</table>

⚠️ Expansion chassis slots are numbered sequentially from left to right. These chassis require a supplemental cooling fan kit.
**G4 with 13-Slot Expansion Chassis**

Pro Tools Expansion Chassis (serial numbers higher than NB0600100C)

Magma PCI–13R

<table>
<thead>
<tr>
<th>Slot</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Slot 1</td>
<td>Chassis Host card</td>
</tr>
<tr>
<td>CPU Slot 2</td>
<td>Empty</td>
</tr>
<tr>
<td>CPU Slot 3</td>
<td>SCSI HBA (Audio)</td>
</tr>
<tr>
<td>Chassis Backplane Slot</td>
<td>Chassis Controller card</td>
</tr>
<tr>
<td>Chassis Slot 1</td>
<td>d24 MIX or Core card</td>
</tr>
<tr>
<td>Chassis Slot 2–6</td>
<td>Additional Pro Tools cards (5 maximum)</td>
</tr>
<tr>
<td>Chassis Slot 7</td>
<td>ABVB card</td>
</tr>
<tr>
<td>Chassis Slot 8</td>
<td>Janus Advanced JPEG card</td>
</tr>
<tr>
<td>Chassis Slot 9</td>
<td>SCSI HBA (Video)</td>
</tr>
<tr>
<td>Chassis Slots 10–13</td>
<td>Empty</td>
</tr>
</tbody>
</table>

⚠️ Expansion chassis slots are numbered sequentially from right to left. These chassis require a supplemental cooling fan kit.
Slot Configurations for AVoption XL

This appendix documents slot configurations for AVoption XL systems, with and without expansion chassis.

9500/9600 without Expansion Chassis

<table>
<thead>
<tr>
<th>Slot</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Slot 1</td>
<td>Macintosh Monitor card</td>
</tr>
<tr>
<td>CPU Slot 2</td>
<td>d24 or MIX Core card</td>
</tr>
<tr>
<td>CPU Slot 3</td>
<td>MIX Farm or DSP Farm cards (if any)</td>
</tr>
<tr>
<td>CPU Slot 4</td>
<td>MIX Farm or DSP Farm cards (if any)</td>
</tr>
<tr>
<td>CPU Slot 5</td>
<td>SCSI HBA</td>
</tr>
<tr>
<td>CPU Slot 6</td>
<td>Avid Digital Video Board</td>
</tr>
</tbody>
</table>

⚠️ CPU speed of 300 MHz or higher recommended. Supports 3:1 video compression or higher (no 2:1 or 1:1).
9500/9600 with 13-Slot Expansion Chassis

Pro Tools Expansion Chassis (serial numbers lower than NB0600100C)
Magma model PCI–13–RX–400V

<table>
<thead>
<tr>
<th>Slot</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Slot 1</td>
<td>Macintosh Monitor card</td>
</tr>
<tr>
<td>CPU Slot 2</td>
<td>Chassis Host card</td>
</tr>
<tr>
<td>CPU Slot 3</td>
<td>Empty</td>
</tr>
<tr>
<td>CPU Slot 4</td>
<td>SCSI HBA (Audio)</td>
</tr>
<tr>
<td>CPU Slot 5</td>
<td>Empty</td>
</tr>
<tr>
<td>CPU Slot 6</td>
<td>Empty</td>
</tr>
<tr>
<td>Backplane Chassis Slot</td>
<td>Chassis Controller card</td>
</tr>
<tr>
<td>Chassis Slot 1</td>
<td>SCSI HBA (Video)</td>
</tr>
<tr>
<td>Chassis Slots 2–3</td>
<td>Empty</td>
</tr>
<tr>
<td>Chassis Slot 4</td>
<td>Avid Digital Video Board</td>
</tr>
<tr>
<td>Chassis Slot 5–7</td>
<td>Empty</td>
</tr>
<tr>
<td>Chassis Slot 8</td>
<td>d24 or MIX Core card</td>
</tr>
<tr>
<td>Chassis Slots 9–13</td>
<td>Additional Pro Tools cards (6 maximum)</td>
</tr>
</tbody>
</table>

⚠ CPU speed of 300 MHz or higher recommended.

⚠ Expansion chassis slots are numbered sequentially from left to right. These chassis require a supplemental cooling fan kit.
Blue & White G3 with 13-Slot Expansion Chassis

Pro Tools Expansion Chassis (serial numbers lower than NB0600100C)
Magma PCI–13–RX–400V
SBS DD2, 240–2–2, or 240–2–201

<table>
<thead>
<tr>
<th>Slot</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Slot 1</td>
<td>Chassis Host card</td>
</tr>
<tr>
<td>CPU Slot 2</td>
<td>Empty</td>
</tr>
<tr>
<td>CPU Slot 3</td>
<td>SCSI HBA (Audio)</td>
</tr>
<tr>
<td>Backplane Chassis Slot</td>
<td>Chassis Controller card</td>
</tr>
<tr>
<td>Chassis Slot 1</td>
<td>SCSI HBA (Video)</td>
</tr>
<tr>
<td>Chassis Slots 2–3</td>
<td>Empty</td>
</tr>
<tr>
<td>Chassis Slot 4</td>
<td>Avid Digital Video Board</td>
</tr>
<tr>
<td>Chassis Slots 5–7</td>
<td>Empty</td>
</tr>
<tr>
<td>Chassis Slot 8</td>
<td>d24 or MIX Core card</td>
</tr>
<tr>
<td>Chassis Slots 9–13</td>
<td>Additional Pro Tools cards (6 maximum)</td>
</tr>
</tbody>
</table>

⚠️ Expansion chassis slots are numbered sequentially from right to left. These chassis require a supplemental cooling fan kit.
Blue & White G3 with 13-Slot Expansion Chassis
Pro Tools Expansion Chassis (serial numbers higher than NB0600100C)
Magma PCI–13R

<table>
<thead>
<tr>
<th>Slot</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Slot 1</td>
<td>Chassis Host card</td>
</tr>
<tr>
<td>CPU Slot 2</td>
<td>Empty</td>
</tr>
<tr>
<td>CPU Slot 3</td>
<td>SCSI HBA (Audio)</td>
</tr>
<tr>
<td>Backplane Chassis Slot</td>
<td>Chassis Controller card</td>
</tr>
<tr>
<td>Chassis Slot 1</td>
<td>d24 or MIX Core card</td>
</tr>
<tr>
<td>Chassis Slots 2–6</td>
<td>Additional Pro Tools cards (6 maximum)</td>
</tr>
<tr>
<td>Chassis Slot 7</td>
<td>Avid Digital Video Media Board</td>
</tr>
<tr>
<td>Chassis Slot 8</td>
<td>SCSI HBA (Video)</td>
</tr>
<tr>
<td>Chassis Slots 9–13</td>
<td>Empty</td>
</tr>
</tbody>
</table>

⚠️ Expansion chassis slots are numbered sequentially from right to left. These chassis require a supplemental cooling fan kit.
### G4 with 13-Slot Expansion Chassis

**Pro Tools Expansion Chassis (serial numbers lower than NB0600100C)**
**Magma PCI-13–RX–400V**

<table>
<thead>
<tr>
<th>Slot</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Slot 1</td>
<td>SCSI HBA (Audio)</td>
</tr>
<tr>
<td>CPU Slot 2</td>
<td>Chassis Host card</td>
</tr>
<tr>
<td>CPU Slot 3</td>
<td>Empty</td>
</tr>
<tr>
<td>Backplane Chassis Slot</td>
<td>Chassis Controller card</td>
</tr>
<tr>
<td>Chassis Slot 1</td>
<td>SCSI HBA (Video)</td>
</tr>
<tr>
<td>Chassis Slots 2–3</td>
<td>Empty</td>
</tr>
<tr>
<td>Chassis Slot 4</td>
<td>Avid Digital Video Board</td>
</tr>
<tr>
<td>Chassis Slots 5–7</td>
<td>Empty</td>
</tr>
<tr>
<td>Chassis Slot 8</td>
<td>d24 or MIX Core card</td>
</tr>
<tr>
<td>Chassis Slots 9–13</td>
<td>Additional Pro Tools cards (6 maximum)</td>
</tr>
</tbody>
</table>

⚠️ Expansion chassis slots are numbered sequentially from right to left. These chassis require a supplemental cooling fan kit.
**G4 with 13-Slot Expansion Chassis**

Pro Tools Expansion Chassis (serial numbers higher than NB0600100C)  
Magma PCI–13–RX–400V

<table>
<thead>
<tr>
<th>Slot</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Slot 1</td>
<td>Chassis Host card</td>
</tr>
<tr>
<td>CPU Slot 2</td>
<td>Empty</td>
</tr>
<tr>
<td>CPU Slot 3</td>
<td>SCSI HBA (Audio)</td>
</tr>
<tr>
<td>Backplane Chassis Slot</td>
<td>Chassis Controller card</td>
</tr>
<tr>
<td>Chassis Slot 1</td>
<td>d24 or MIX Core card</td>
</tr>
<tr>
<td>Chassis Slots 2–6</td>
<td>Additional Pro Tools cards (6 maximum)</td>
</tr>
<tr>
<td>Chassis Slot 7</td>
<td>Avid Digital Video Media Board</td>
</tr>
<tr>
<td>Chassis Slot 8</td>
<td>SCSI HBA (Video)</td>
</tr>
<tr>
<td>Chassis Slots 9–13</td>
<td>Empty</td>
</tr>
</tbody>
</table>

⚠️ Expansion chassis slots are numbered sequentially from right to left. These chassis require a supplemental cooling fan kit.
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A</strong></td>
</tr>
<tr>
<td>ABVB cable 16</td>
</tr>
<tr>
<td>ABVB card</td>
</tr>
<tr>
<td>cable connectors 16</td>
</tr>
<tr>
<td>installing for AVoption 13</td>
</tr>
<tr>
<td>ABVB output 18</td>
</tr>
<tr>
<td>ADU2 drive 16, 28</td>
</tr>
<tr>
<td>aspect ratio 45</td>
</tr>
<tr>
<td>ATTO EPCI-DC card</td>
</tr>
<tr>
<td>installing for AVoption 14</td>
</tr>
<tr>
<td>ATTO SCSI card 26</td>
</tr>
<tr>
<td>audio hardware</td>
</tr>
<tr>
<td>installing with AVoption 13</td>
</tr>
<tr>
<td>installing with AVoption XL 24</td>
</tr>
<tr>
<td>authorizing and deauthorizing</td>
</tr>
<tr>
<td>AVoption 12</td>
</tr>
<tr>
<td>AVoption XL 24</td>
</tr>
<tr>
<td>FilmFrame 12</td>
</tr>
<tr>
<td>available record time 37</td>
</tr>
<tr>
<td>AVoption</td>
</tr>
<tr>
<td>authorizing and deauthorizing 12</td>
</tr>
<tr>
<td>capabilities 1</td>
</tr>
<tr>
<td>compression (video) available 3</td>
</tr>
<tr>
<td>hardware capabilities 3</td>
</tr>
<tr>
<td>resolutions (video) available 3</td>
</tr>
<tr>
<td>setup illustration 20</td>
</tr>
<tr>
<td>AVoption XL</td>
</tr>
<tr>
<td>authorizing and deauthorizing 24</td>
</tr>
<tr>
<td>capabilities 2</td>
</tr>
<tr>
<td>hardware capabilities 7</td>
</tr>
<tr>
<td>installing a new system 23</td>
</tr>
<tr>
<td>striped drive requirements 10</td>
</tr>
<tr>
<td>video connectors 30</td>
</tr>
<tr>
<td>AVR 3</td>
</tr>
<tr>
<td>disk space used 4</td>
</tr>
<tr>
<td><strong>B</strong></td>
</tr>
<tr>
<td>black burst 9, 17</td>
</tr>
<tr>
<td>connecting to AVoption XL 32</td>
</tr>
<tr>
<td>Blocks view 36</td>
</tr>
<tr>
<td>BNC</td>
</tr>
<tr>
<td>connecting 17</td>
</tr>
<tr>
<td>removing 17</td>
</tr>
<tr>
<td>B-Y IN 17</td>
</tr>
<tr>
<td>B-Y OUT 17</td>
</tr>
<tr>
<td><strong>C</strong></td>
</tr>
<tr>
<td>centralized video</td>
</tr>
<tr>
<td>switching and routing for AVoption XL 33</td>
</tr>
<tr>
<td>compression 3</td>
</tr>
<tr>
<td>approximate storage space 4, 8</td>
</tr>
<tr>
<td>setting level 37</td>
</tr>
<tr>
<td>with JPEG 4</td>
</tr>
<tr>
<td>configuring</td>
</tr>
<tr>
<td>AVoption with a single VGA monitor 18</td>
</tr>
<tr>
<td>PCI slot configurations for AVoption 13</td>
</tr>
<tr>
<td>connecting</td>
</tr>
<tr>
<td>AVoption</td>
</tr>
<tr>
<td>a VTR 18</td>
</tr>
<tr>
<td>ABVB 16</td>
</tr>
<tr>
<td>BNC connector 17</td>
</tr>
<tr>
<td>NTSC monitor 18</td>
</tr>
<tr>
<td>PAL monitor 18</td>
</tr>
<tr>
<td>reference video monitor 18</td>
</tr>
<tr>
<td>USD 17</td>
</tr>
<tr>
<td>AVoption XL 33</td>
</tr>
<tr>
<td>a VTR 32</td>
</tr>
<tr>
<td>house sync 32</td>
</tr>
<tr>
<td>PAL monitor 33</td>
</tr>
<tr>
<td>reference video 33</td>
</tr>
<tr>
<td>Universal Slave Driver 32</td>
</tr>
<tr>
<td>USD 32</td>
</tr>
<tr>
<td>black burst 17</td>
</tr>
<tr>
<td>external playback monitor 44</td>
</tr>
<tr>
<td>house sync 17</td>
</tr>
</tbody>
</table>
CV IN 17
CV OUT 16

D
deauthorizing and authorizing
AVoption 12
AVoption XL 24
Digital Media card 25
DigisTranslator 39, 40
disk allocation 10
Round Robin 5

E
exporting
audio 40
entire clip or sequence 40
file type 40
files from Media Composer 40
from Media Composer 40
media online 40
OMFI Version 2.0 40
overview 39
part of a sequence 40
render effects in advance 40
selecting specific tracks 40
video 40
video and audio 39
video only 39
With Media 40
ExpressPro-Tools 26
flashing SCSI ROM 15
external playback monitor 44
connecting 44
NTSC 44
PAL 44

F
FilmFrame
authorizing for AVoption 12
installing for AVoption 12
overview 2
flashing
SCSI ROM with ATTO ExpressPro-Tools 15, 26
frame boundaries, adjusting to 43
Frames view for Movie track 36

G
GL IN 16

H
hard drives
contiguous file capture on multiple 5
initializing for AVoption 15
initializing for AVoption XL 26, 27
Round Robin allocation for audio 5
selecting for video capture 37
space required for each AVR level 4
space required for each JFIF level 8
using more than two 5, 9
using two 5, 9
video for AVoption 5
house sync 5, 9, 17
connecting to AVoption XL 32

I
I/O Box, Meridien 29
illegal frame boundaries 43
Importing files
preparing 39
initializing
hard drives for AVoption 15
hard drives for AVoption XL 26, 27
installing
ABVB card for AVoption 13
authorizing AVoption 12
AVoption
ATTO EPCI-DC card 14
audio hardware 13
FilmFrame 12
new system 11
SCSI accelerator 14
software 12
upgrade 11
video hardware 13
AVoption XL
ATTO EPCI-UL2D card 26
audio hardware 24
authorizing 24
Digital Media card 25
Meridien I/O Box 25
new system 23
SCSI accelerator 26
software 24
upgrade 23
video hardware 25
Janus advanced JPEG card for AVoption 13

J
Janus advanced JPEG card
installing for AVoption 13
JFIF, disk space used 8
JPEG 4
  compression and video storage 4

L
locking the Movie track 47

M
MachineControl 38
media management
  AVoption
    ADU2 drive 16
    SCSI channel to video drives 16
  AVoption XL
    ADU2 drive 28
    SCSI channel to video drives 28
Meridien I/O Box 25, 29
monitors
  connecting NTSC 33
  connecting PAL 33
Movie Offline, working with 43
Movie Online, working with 43
Movie track
  clearing track 36
  creating 35
  deleting 36
  Frames view 36
  locking 47
  naming 36
  overview 35
  viewing as blocks 36
Movie Window 44
  aspect ratio 45
  showing 45

N
NTSC 19, 33
  connecting 18
  switching between NTSC and PAL 33
NTSC and PAL
  switching between 19
  using 19
NTSC monitor 33

O
Offline Movie 43
Online Movie 43

P
PAL 19, 33
  connecting 18
  switching between NTSC and PAL 33
Pal and NTSC 19
  switching between 19
performance guidelines
  for AVoption and AVoption XL 42
performance with windowed playback 44
Preparing to Import Files 39

Q
QuickTime movies, importing 41

R
recording video 38
  selecting target volumes 37
  selecting video input 37
  setting compression level 37
  setting options 37
removing
  BNC connector 17
render effects before exporting 40
resolution (video) 3
Round Robin 5, 10
routing and switching
  centralized video for AVoption 18
R-Y IN 17
R-Y OUT 17
S
sample AVoption setup
illustration 20
SCSI accelerators
for AVoption 5
for AVoption XL 9
installing for AVoption 14
installing for AVoption XL 26
SCSI channel 16
SCSI ROM
flashing with ATTO ExpressPro-Tools 15, 26
selecting target volumes for video capture 37
selecting video input 37
setting video recording options 37
show Movie Window 45
storage
using more than two hard drives 9
using two hard drives 9
striped drives 10
switching and routing
centralized video for AVoption 18
centralized video for AVoption XL 33
sync points, identifying 47
synchronization 9
synchronization peripheral 5
system requirements 5

U
Undo/Redo for Video Editing Commands 42
Universal Slave Driver 5
connecting 17, 32
required for AVoption XL 9
upgrading AVoption XL 23
USD 5, 9
connecting 17, 32

V
variable compression with JPEG 4
VGA monitor, configuring 18
video
AVoption
ABVB video cable 16
available video resolutions 3
Avid Video Resolution and compression 3
cables 16
captured to multiple hard drives 5
centralized video switching and routing 18
connecting ABVB video cable 16
connections 16
hard drives 5
installing hardware 13
JPEG 4
switching between NTSC and PAL 19
synchronization and black burst 5
AVoption XL
centralized video switching and routing 33
installing hardware 25
qualified and required SCSI accelerators 9
switching between NTSC and PAL 33
video and audio export 39
video cable
AVoption connectors 16
video clips
clearing selection 46
copying 46
video connectors
AVoption 16
AVoption XL 30
B-Y IN 17
B-Y OUT 17
CV IN 17
CV OUT 16
GL IN 16
R-Y IN 17
R-Y OUT 17
Y IN 17
Y OUT 17
video only export 39
video signal
centralized routing 18
selecting 37
viewing with external monitor 44
video storage
disk space used 4, 8
viewing blocks in the Movie track 36
viewing the Movie in a window 44
VTR
correcting 18
connecting to AVoption XL 32
window playback
of the Movie 44
performance 44
Y
Y IN 17
Y OUT 17